Table of Contents

1 Thank you ........................................... 3
2 Quick Start Guide (Asia) .................................. 4
3 First Steps .............................................. 10
4 Using Tedds ............................................. 11
5 Writing Tedds Calculations - Stage 1 ..................... 26
6 Using Library Calculations in Tedds for Word. ........... 36
7 Writing Tedds Calculations - Stage 2 ..................... 44
8 Enhancing Calculations .................................. 51
1 Thank you

Thank you for choosing Tedds. We are confident that you will find it invaluable and we look forward to getting to know you and your business.

To get you up and running quickly, we've supplied this *Quick Start Guide*\(^1\) accessed through the 'Help' menu, which means you should be able to run or create your own calculations in about an hour. After that, you will easily go from novice to expert, simply by using the 'Help' menu and the manuals we've provided as PDFs.

If you have any comments or ideas about Tedds, please get in touch and share them with us. We aim to provide the very best solutions and feedback from our customers is vital to us.

Enjoy using Tedds, we look forward to hearing from you.

*The Tedds team*

1.1 Installation and licensing

For instructions on installing and licensing Tedds please read the *Software Installation and Licensing Guide.pdf* located in the root folder of the Tedds installation CD.

---

**Footnotes**

1. This document was prepared for Tedds 2016. If you are using a newer version of the software some features may vary.
2 Quick Start Guide (Asia)

2.1 Introduction
First of all, congratulations on your choice of Tedds and welcome to the Tedds Quick Start Guide. Tedds is a tool that will dramatically increase your productivity, and which will become as indispensable to you as your calculator, so much so that you'll wonder how you ever managed without it. Thousands of engineers worldwide have already realised the benefits Tedds offers and so can you.

We are sure that, at the moment, you will have many questions about Tedds but probably at the forefront of your mind are:
- What is Tedds?
- Why Tedds and Tedds for Word?
- How do I use it?

That's where this guide comes in. The best way to answer these questions is to show you, so this guide includes examples for you to do (not just to read), and thereby learn about Tedds, and how to use it, in the most effective manner possible - by doing.

First we will show you that you can be confident and productive in using Tedds in a matter of minutes. Then we will move on to show you how to realise its full potential, and how a little investment in time and effort now means that you can reap huge rewards in the future. We know that your time is precious, so let's get started.

2.2 What is Tedds?
First of all, and most importantly, Tedds is an application written by Structural Engineers for Structural Engineers, not just a number cruncher written with accountants and scientists in mind. Furthermore, Tedds is a proven system that has been in use and development for over 20 years. You use a calculation from the Tedds Engineering Library written by our
experienced in-house engineers covering a wide range of common engineering tasks, you can create and edit your own calculations, or you can mix both of these approaches.

Tedds Engineering Library

In the *Tedds Engineering Library* you will find calculations for determining loading...
...for the *Analysis and Design* of many types of elements and constructions...

...and much more. Each calculation is essentially a sophisticated design program in its own right. Every calculation you perform can be saved discretely, and re-calculated any number of times, in a matter of moments, to refine your design, or to cater for changes. But that's not all...

### 2.2.1 Tedds Engineering Utilities

Along with the calculations in the library you also get all these great features and utilities:

- *Data Lists* make masses of engineering data easily and instantly accessible,
• Tedds unique interactive Data Tables which feature Automatic Interpolation and Search functions,

• These intuitive tools are integrated with all our calculations, so you have the information you need at your fingertips as you use the calculation. What's more, you can integrate Data Lists and Data Tables into your own calculations.

• Tedds has all the Engineering Values, Math and Logic functions you need, and it automatically handles Units (Metric and Imperial). You can consign your conversion factor tables to the bin - Tedds takes care of them automatically. This means that writing your own powerful calculations is very easy.

\[ 15.5\text{mm} \times 1.25\text{in} \times \rho_{5950} + 8\text{kg} / 1.4\text{cm} = 575.3 \text{kg/m} \]
• What else do you need? How about a **Section Properties Calculator** that automatically determines the properties of sections composed of a huge variety of shapes and materials? With Tedds you've got it...

![Section Properties Calculator](image1)

• ...and a **2D Frame Analysis Tool** that can be used for linear static analysis of frames with unlimited nodes, and for multi-span **Continuous Beam Analysis**,

![2D Frame Analysis Tool](image2)

• So, as you can see, Tedds is an indispensable toolbox for the practising engineer. In fact, we believe it's what you've been looking for all this time!
2.3 **Tedds and Tedds for Word – What is the difference?**

You can run Tedds in two *modes*. One - which we call just Tedds - is very simple, very powerful, completely self-contained and requires no knowledge of any other package. This mode gives you access to all the major Engineering Library calculations and utilities, and is the best place to start using Tedds. We will look at this mode first below.

The other mode - Tedds for Word - is even more powerful and is *entirely* integrated with *Microsoft® Word* - in fact it operates *in Word*. So, of course, you need *Word* (and it helps to have a little knowledge of it). In this mode you can run all the Tedds Engineering Library calculations and utilities and also have all the editing features of *Word* at your disposal to create really complete and professional looking reports. In this mode you can also write your own calculations.

2.4 **How do I use Tedds?**

Now, you probably started off asking of Tedds - *What does it do?* Well, we have shown you that Tedds can do so *much*, that a better question is:

- What do you want to do?

Take a look at the task-list below - we guess that you have needed or wanted to do most of these things some time:

- Check that a rectangular hollow section, subject to compression and bending, is OK and produce a smart, finished calculation to show this.
- Create your own custom calculations to speed up and take the tedium out of some repetitive calculations.
- Create calculations in a *Word* document ready to include in a report.
- Determine the load chase down and wind loads on a building and include these calculations in a final report.
- Create your own sophisticated custom calculations suitable for others to use.

If you could have done with some help with these, you have it now with Tedds.

The examples that follow will *show* you how easy this is in Tedds: simply *do* them. The examples build on one another, and so are best attempted in the order that they appear. We give you the rough time that each example will take, so you know that you have time to finish it.

---

**Watch out for key points** highlighted like this in the guide. All the information in this guide is useful and important, but this information is especially so.

For more help and tips on using Tedds don’t forget to read the comprehensive help system available in both Tedds and Tedds for Word.
3 First Steps

If you haven't installed Tedds, then insert the CD into your computer's CD/DVD drive, and follow the on-screen instructions to install it.

Once Tedds is installed, you will find its icon (shown below) on your desktop:

1. **Double-click** the icon to launch the program.

2. If this is the first time you are starting Tedds, or if you are updating from a previous version of Tedds, then you will see the Tedds Setup Wizard which allows you to configure Tedds with your company details and so on. Work through the various pages of the Wizard and when you reach the end click **Finish**.

3. The **Start Tedds** menu will display.

4. Choose the **version** of Tedds you wish to run (to start with we shall use Tedds rather than Tedds for Word) so click Tedds.

   Alternatively, you can click the **Start** button on the **Windows** task bar, select **All Programs/Tekla/Structural/Tedds/Start Tedds**.
4 Using Tedds

4.1 Exercise 1: Design of steel section.
In this exercise you will learn how to use any of the calculations in the extensive Tedds Engineering Library.

Allow about 15 minutes to complete this exercise.

We wish to check the following RHS steel beam:

**Design Information:**
- Design Code; = EN1993
- Dimensions; Length; = 5.0 m
- Effective length factors; = 0.85
- Design Forces; Moment; = 135 kNm
- Shear; = 60.0 kN
- Axial compression; = 40.0 kN
- Proposed section; RHS preferred

4.2 Running Tedds and Locating Calculations
You need to find an appropriate calculation, run it and enter the design information. You will see just how easy this is.

1. Launch Tedds from the icon on your desktop.

2. If this is the first time you are starting Tedds, or if you are updating from a previous version of Tedds, then you will see The Tedds Setup Wizard which allows you to configure Tedds with your company details and so on. Work through the various pages of the Setup Wizard and when you reach the end click Finish.
3. From the *Start Tedds* menu click the version of Tedds to run.

4. Again if this is the first time you have run Tedds, or if you are updating from a previous version you will see a licensing window. If you want to use the email option (recommended) it’s a good idea to do so now. When you are ready to proceed click *Close* to shut the licensing window and run Tedds (you have a two day period during which you can use Tedds without entering the unlock code).

5. Now you will see the *Tedds Start Page*:

6. Click *New Document...* and you will see the *Select Calculation* dialog:
7. Click on the All folder.

- The instructions about using Tedds are displayed in the right hand panel.
- Every Tedds calculation is listed in the left hand panel.
- When you click on a calculation, notes relating to it are displayed on the right side.

If the Show Examples option is checked, you will also see all of the examples that are included in the library - these demonstrate the potential scope of each of the calculations and show you the typical output.

To find a calculation – you could simply click on a folder in the list to open it, then click a heading to select a calculation. However for this example the Find in list feature will be used instead.

8. Type steel member design in the Find in list box.

Find in List will locate the first item title in the library that contains the exact text entered. Keywords in the item description are also considered provided the option to Find in item descriptions remains checked.
9. The first item in the library matching the entered text is selected - we are looking for the *Steel member design (EN1993)* calculation. If necessary click *Next* until it is selected as shown below.

![Select Calculation Dialog]

Note there is also a 'Steel beam analysis & design (EN1993)' calculation available which will determine the design forces before proceeding to the design.

10. Click the *Calculate* button at the bottom right of the dialog: three things will happen:
   - A new calculation document will open – you will see this in the background.
   - The *Interface* for the chosen automated calculation will be displayed at the first page.
   - Another window, titled the *Progress Log* will also be displayed – we will explain this shortly.
4.3 Entering Data in the Automated Calculation User Interface

The user interfaces for all of the calculations in the Tedds engineering library use a consistent style which ensures they are easy to use. You select the design options you require and enter values for dimensions, loading etc. all of which are clearly explained. See the box below for more information.

The General Automated Calculation Interface Explained

An ‘I’ symbol to the left of a variable description shows that there is more information available about this particular variable.

The yellow information area (at the top of the dialog) displays any information about the selected variable (if available). You can

In the left hand column are:

Notes - which display details on the calculations being performed,

Sketches - which display an appropriate sketch for the calculations,

Variables - this lists all the current variables, values can be selected from here to enter into the current interface,

Feedback - this allows you to send feedback to the development team,

Support - tells you how to obtain support in your region.

A button will allow you to enter more information or select a particular item.

At the bottom of the interface you can click Next to continue to the next page, Back to return to a previous page, Cancel to stop the calculations at the current point, and Finish to return the data to your calculation document.

Enter information in the data fields. Where appropriate, variables may have validation and prevent invalid information being entered.
1. In this calculation all the values for design forces and section details can be specified on the first page of the interface and the calculation results are also displayed.

![Image of the interface with design information and options]

Note that additional design and output options are available by clicking the appropriate buttons.

Before we proceed to enter the data take a moment to review the “Design Information:” on page 11

2. Enter the Design bending moment - major axis as 135 kNm.
3. Enter the Design shear force - major axis as 60 kN.
4. Finally for the Axial load applied, select Compression load and enter a value of 40kN.

Note that as you change the values and options for your design the calculation results are immediately updated.
5. Now you need to choose a section to check, but you don’t need to go off and find a list of section properties, since all the data required can be accessed within Tedds. Click the 'Section...' button to display the Data List for steel sections.

4.4 Data Lists

You are now looking at a Data List: a tool that allows you to choose a section and see its properties at the click of a button.

In this case, both a 250x150x10 RHS and a 300x200x6 RHS may prove adequate but which is the lighter?

1. Scroll down past the Continental and Chinese sections. Click the Rectangular Hollow Section section type - this is known as the Data List page you require.

2. Select the size and thickness you require.

3. Click on the Details button to see all the properties of the selected section – (note that the details window updates instantaneously when you click on another section).

Note that this particular datalist contains sections from a range of sources; Continental sections are at the top, followed by Chinese, then Perwaja and then European sections.
4. Check the properties of both sections. The 300x200x6.0 RHS section is lighter and may be preferred – choose this section and click the Select button to continue with the calculation using this section size.

```
You will find Data Lists for all kinds of engineering data throughout Tedds calculations; there are data lists for bolts, reinforcing bars, timber sections and much more. However, they all work in just the same simple and intuitive way.
```

5. The Number of sections option allows you to design beams using two or more sections. In this example a single section is sufficient so no change is required.

6. Enter a restraint spacing of 5000mm, for both the major and minor axes.

```
| Restraint spacing - Major axis | 5000 mm |
| Restraint spacing - Minor axes | 5000 mm |
```

7. The calculation results show that the section is passing all the checks but you have yet to confirm the effective length factors for compression buckling. Click the Design options... button to view another interface page.

8. Leave the default values as shown.

```
Equivalent uniform moment factors:
- Major axis moment factor C_maj: 1
- Minor axis moment factor C_min: 1
- Lateral torsional moment factor C_tort: 1
```

9. Click OK to return to the main page of interface and check the calculation results.
10. You can now choose the level of output you require by clicking the *Output options*... button. From here you can also give the calculation a title.

![Output options](image)

### 4.5 Automated Calculations and Library items

You have probably realised by now that this calculation caters for all kinds of steel sections, dimensions and loading. For each possibility and check, there is an *item* in the *Library* - in fact this calculation has over 150 items. When you use a calculation like this, Tedds automatically chooses the appropriate items for your options and input, and puts them together to make up the complete design.

1. Accept the results and continue. Note that the interface has finished and you now have a *Finish* button to click:

![Finish button](image)

### 4.6 The Progress Log

The progress log helps to keep you informed about a calculations progress during lengthy calculations, it is also used by some calculations to report the status of specific checks or other pertinent information. When writing your own custom calculations you can add information to the log or you can modify the default options to provide more detailed information about what your calculations is doing which can be helpful for resolving errors.

![Progress log](image)
This particular calculation does not use the progress log to report any additional information.

4.7 Examining Finished Calculations

OK, but how is your chosen section performing? The main interface displayed the design forces, capacities and utilisations but you may want to examine the results in more detail.

1. Scroll through the calculation and examine the \textit{y-y axis flexural buckling resistance} check:

\begin{center}
\begin{tabular}{|l|c|}
\hline
\textbf{Check y-y axis flexural buckling resistance - Section 6.3.1.1} & \\
\hline
Buckling curve - Table 6.2 & B \\
Imperfection factor - Table 6.1 & 0.21 \\
Buckling determination factor & \( \phi_i = 0.5 \times (1 + \alpha_l \times (\bar{\lambda}_y - 0.2)) = 0.681 \) \\
Buckling reduction factor - eq 6.49 & \( \chi_l = \min(1, \{\phi_i + \gamma(\bar{\lambda}_y - \bar{\lambda}_y^2)\}), 1) = 0.922 \) \\
Design buckling resistance - eq 6.47 & \\
\hline
\end{tabular}
\end{center}

2. There's another really important point to note about the calculations displayed – they don't just show you results, but how those results have been arrived at.

Tedds is not a ‘black box’ where all you can see is the result, and all you can do is accept it. In Tedds you can see exactly what's going on. You can see what checks Tedds does. What design method does it use? From where did that number come? The answers to all these questions are right there in front of you! This is a major reason why Tedds is so popular with engineers the world over.

Furthermore, if you need an example of how to write your own calculations, then look no further. That's exactly what you are looking at - every calculation in the library is an example of how to write your own. How do I write a math expression in Tedds? How do I use logic or a math function in Tedds? Look again at the check shown above and you will see the answers to these questions. We will look more closely at how to write your own calculations beginning with “Writing Tedds Calculations - Stage 1” on page 26.
4.8 Re-Calculating

Changes are a fact of life for engineers, they always have been, and they always will be! You need to be able to take account of any changes and update your calculations quickly. With Tedds this is no problem.

Say that your beam needs to be 0.1 m longer since the beam which supports it needs to be moved, to avoid a clash. Is your section still OK?

1. Click the Calculate button on the Home tab (highlighted above).
   The calculation will run again, but this time all the information you entered last time is remembered. It's a simple matter to change the required data.

2. Change the distances between restraints to 5100 mm.

3. What is the effect of this change on the design? Check the Calculation results and/or the output to see.
   Tedds makes it easy to update calculations – simply re-calculate and you can update your design quickly.

4.9 Hidden Text

For those calculations that make use of the Progress Log you may notice the following message at the end of the Progress Log text:

“Note: some calculations may be in hidden text”

All the calculations performed by Tedds are available in the output and in general so they are – but at times some intermediate calculations are hidden to reduce the amount of output. It is simple to view these and to include them in your printout.

1. Open the application's View tab then use the Hidden Text option and examine the check again. You will see all the hidden text underlined with dashed lines.
2. In this example there are no hidden calculations but you will see the names of the Library items used in the output.

3. Select View/ Hidden Text again to hide the Library item names. Now let us consider how to print calculations.

4.10 The Header & Printing

Obviously you want professional looking printed output. You will see that you have a header region at the top of the calculations, but how do you set its details?

1. Click the Header button highlighted above – this opens a dialog where you can enter the information you want. Enter the project details shown below, or something similar, for your header.

2. On the Company page you can define your own company details. Do this now, if you want to. If you don't, then remember to do so before you print your first “proper” set of calculations.
3. On the Template page you will see the Tedds template which your calculations will use and the logo file which Tedds will add to the template. You can change the template and logo if necessary – click this tab and check that its details are correct.

4. Maybe you would like to try a different style of template, there are a number of standard templates to choose. Click the Select... button to see these. Choose the template you want to use and you will see a preview of what calculations produced with that template will look like. When you have found the template you want to use click OK to use it.

5. If you have a copy of your company logo in electronic format, and the template style you select supports a logo, then you can add your logo to the template. Make sure that the logo is available on your computer, Browse to find it, and then click OK to add it to the template.

6. Click OK to exit the Header Properties dialog and view your finished calculation.

7. If the logo is not the right size open the Header Properties dialog once more and change the Scale of the logo to make it fit the template correctly.

8. Once the template and logo are correct click to display the File Menu. From here you can Print the calculation to obtain a hard copy.

9. Congratulations, you have produced your first piece of work with Tedds!

To finish this example let's look at a few points about saving and outputting your results.

4.11 Saving and Output Options

You can save every Tedds calculation to a unique file that you can recall and edit any time in the future. The file extension .ted is unique to Tedds.
1. Click to display the File Menu.

2. Save your file and give it a name - it's a good idea to save all the examples you will produce in the course of completing the guide, for future reference.

3. The output you see in the document can be printed direct to a printer, but you have other options.

4. Click the drop-down button adjacent to Send To on the File Menu to view these.

5. Choose the option of sending the output to Word and experiment with the other options if you wish. Once your output is in a Word document, you can edit it as much as you wish.

4.12 Performing a New Calculation

How do you start a new calculation in Tedds?

1. Click to display the File Menu; then click The Select Calculation dialog will open, from where you can select and start a new calculation in a new document.

4.13 Managing Multiple Related Calculations

Can several calculations be saved in a single document?

As stated earlier, each calculation must be saved to a unique file - however multiple files can be collected together in a single project. They can then be organised as required using the Project Manager.

Benefits of projects include:

• you can specify a shared document header for all the project files,
• locating files is made easier - when you open the project all files within it are opened automatically,
• calculations can be placed into named groups, making them easier to manage.

To start a new project:

1. Click to display the File Menu; then from the menu choose the New Project button.
A new empty project is created in the *Project Manager.*

2. New or Existing Documents are then added and arranged into folders as required via the *Project* tab.

4.14 What Next?

Congratulations! You have completed the first exercise and now know all you really need to make use of the wide range of calculations available in the Tedds *Engineering Library* and to begin using Tedds productively. Take a look through the index and try some more. How about:

- carrying out a wind load calculation?
- designing a retaining wall?
- designing an RC footing?
- analysing and designing a timber rafter, beam or post...

The choice is yours, and all these calculations work in the same straightforward, intuitive way. Some calculations may also include Data tables which are designed to look like tables from printed references, so that you immediately feel at home with them. Indeed we hope you will find yourself recognising them.

What can you do if the Library does not contain the exact calculation for which you are looking? You need to perform a number of calculations, and could do with a calculation to help you out with these. First of all, *TELL US:*

- if you are running a calculation, then you will see a *Feedback* button to the left-hand-side of the interface,
- if you are not running a calculation, then you can choose the *Feedback...* option from the *Help* menu.

We are constantly working to expand our *Engineering Library* and your input helps us do this!

But you don't have to wait until we produce these for you – you can write them yourself. We will look at this in the next example.
5 Writing Tedds Calculations
   - Stage 1

Having looked at using calculations from the Tedds Library we can move on to look at one of the most exciting and powerful features of Tedds - the ability to create your own calculations. This is where an initial investment of time can give you huge returns later. Once you have invested time writing a Calculation, you can use it over and over again, you can also update calculations in an instant, making further great savings. You can also customise and extend the Library of Tedds calculations to match the calculations that you use most frequently in your office.

5.1 Exercise 2: Writing Tedds Calculations

In this exercise we will see that writing Tedds calculations simply uses the math and logic conventions with which you are already conversant. We start by looking briefly at very simple examples introducing the basics of calculating with Tedds for Word. We then create a “real-world” example, covering the main features of writing effective calculations in depth.

Allow about 30 minutes to complete this exercise.

5.2 Running Tedds for Word

To write calculations you need to use Tedds for Word.

1. Launch Tedds from the icon on your desktop

2. Click the option to run Tedds for Word - Microsoft Word will now open with Tedds integrated. If this is the first time you’ve run Tedds for Word a Release Notes document and the Library Access System will open too.

It is important to realise that you are looking at Microsoft® Word with the Tedds capabilities added. We only add to the functionality of Word, so you can do anything you would normally do in Word. Treat a Tedds Calculation Document just like you would any ordinary Word document. You can type reports, import files and text, embed spreadsheets and so on. And of course you can add calculations to your reports; either straight out of the Tedds Engineering Library, just as you did in the previous exercise, or create your own.
5.3 The Tedds interface

The commands you will need to use in this exercise can all be found on the Tedds Tab of the ribbon as highlighted below:

You will find a Word Document open, which looks very similar to the Tedds output document.

The document Header can be edited in a similar manner to that in Tedds by clicking the Edit Header button - this button is highlighted above.

1. In this exercise two documents will be required, so open a new blank one by selecting File/New Tedds Document.

Now we are ready to begin writing our first calculation in Tedds.

5.4 The Basics

Writing calculations in Tedds for Word is easy. Tedds follows standard mathematical rules and uses standard mathematical operators. For example 1 + 2 would add 1 to 2. To write an equation use the = sign, and to specify where you want to see the answer use the ? symbol. For example:

1 + 2 = ?

1. Type the above anywhere in your document. When you calculate this equation the ? will be replaced with the answer.

5.5 Calculating in Tedds for Word

To calculate equations in Tedds you can use one of several icons:

- **All** - this will calculate the whole document.
- **Calculate Section** - this will calculate the Calc. Section your cursor is in.
- **Calculate Selection** - this will calculate only equations you have highlighted.

1. Click the Calculate All button to calculate your equation:

1 + 2 = 3.000
1. You should find the answer displayed in your document as shown above. If you have an error, turn to “Errors and Troubleshooting” on page 33.

5.6 Units in Tedds

Tedds automatically takes units into account, so you don’t need to apply conversion factors to get the right answer. Tedds will also check that the units you are using are dimensionally correct and warn you if they aren’t.

1. Type the following in your document using the same case as you see here:

   890 mm + 1 ft + 8.5 in = ? m

1. Click the Calculate All button to calculate this equation:

   890 mm + 1 ft + 8.5 in = 1.411 m

1. You should find the answer displayed in your document as shown above. If you have an error, turn to the section “Errors and Troubleshooting” on page 33.

5.7 Defining and Using Input Variables in Tedds

*Defining variables* is the key to writing effective Tedds calculations. We will use the following calculations to demonstrate this. **Do not type this yet** - we will show you how to enter the calculation below (in stages) in the following couple of pages.

**STEEL SECTION TIE DESIGN**

- Min. yield strength; \( F_y = 275 \text{ N/mm}^2 \)
- Design strength; \( F_a = 0.6 \times F_y = ? \text{ N/mm}^2 \)
- Tie force; \( T_f = 450 \text{ kN} \)
- Min gross section area; \( A_{\text{MIN}} = T_f / F_a = ? \text{ cm}^2 \)
- Tie effective length; \( L_e = 5 \text{ m} \)
- Slenderness limit; \( \lambda_L = 300 \)
- Min. radius of gyration; \( r_{\text{MIN}} = L_e / \lambda_L = ? \text{ cm} \)

1. Close the current document, (because two documents were opened at the beginning of the exercise you should still have an empty one displayed).

2. Type in the following two paragraphs in the empty document.

**STEEL SECTION TIE DESIGN**

- Min. yield strength; \( F_y = 275 \text{ N/mm}^2 \)
The first paragraph is just a title for our calculation. The second paragraph is a standard Variable Definition which uses a superscript in its units.

3. To type the unit $N/mm^2$, first type $N/mm$, then click the Superscript button:

4. Now type 2, then click the button again to return to normal text. Once you have finished typing, read the notes in the box below for an explanation of a standard variable definition, and to check you have typed it correctly.

The Standard Variable Definition Explained

Note the following:

- The expression defines the variable's unique name, current value and units.
- Variable names are case sensitive, cannot contain spaces or be function names (like sin for example). Other than that you can use pretty much anything you like as you can see, including Greek text and Subscripts.
- The semi-colon is important. It is a delimiter that separates an expression from text, or another expression in the same paragraph. If you omit delimiters in either of these cases, then you will get an error when you calculate your document.
- The equality sign '=' defines an expression. Without it no calculation will be performed.
- Spaces and Tabs are not significant in this, or any other, expression. Use as many or as few as you wish to make your calculations look presentable and easy to read.
- We will look at Units in more detail shortly but, for now, note that they are also case sensitive and have a correct syntax, that you must use (as shown above).

1. Now enter the following paragraph which uses this variable:

   Design strength; $F_a = 0.6 \times F_y = ? N/mm^2$

2. Use the Multiply Symbol button to enter the $\times$ mathematical operator - do not use a lower-case x:
3. Check the notes in the box below for a detailed explanation of the components of this paragraph.

Mathematical Expressions Explained

- The same observations as before apply to delimiters, explanations, spaces and units.
- You cannot omit math operators in expressions: Tedds cannot calculate \(0.6F_y\), you must type the expression as shown above, including the \(\times\).
- The result field \(?\) is used to tell Tedds where the result should be output - when calculated the \(?\) will be replaced with the result of the expression.
- The value of the result will be in the result unit you specify. Ensure this has the correct form and dimensions. Do not omit this.
- The expression contains a variable \(F_y\) that is defined in the calculations before (that is above) the point where it is used. Expressions should not contain variables that are not yet defined.
- The expression contains two equalities and performs two functions:
  - calculates and displays the value we wish to know - the result.
  - assigns this result to a variable named - \(F_a\)
- It is not obligatory to always do this. You can write a valid expression to perform just one of these functions by either omitting the variable name and the first equality, or the second equality and the \(?\) and unit.

4. Now click the Calculate All button to calculate your calculation.

\[
\text{Design strength; } \quad F_a = 0.6 \times F_y = \, ? \quad \text{N/mm}^2
\]

5. Your expression has been calculated and the result has replaced the \(?\) as before. If you have an error, turn to “Errors and Troubleshooting” on page 33

6. Here are the next two paragraphs of the calculation. The first paragraph is a standard variable definition, while the second uses both \(T_f\) and \(F_a\) to determine the minimum section area and creates a variable \(A_{\text{MIN}}\) with this value.

\[
\text{Tie force; } \quad T_f = 450 \text{ kN}
\]
\[
\text{Min gross section area; } \quad A_{\text{MIN}} = T_f / F_a = \, ? \text{ cm}^2
\]

7. Type the first paragraph, then follow the steps below to enter the second.

8. The second paragraph contains examples of the use of subscript (often used for name suffixes) and superscript (used for powers).
9. To type the variable name $A_{MIN}$, first type the $A$, then click the Subscript button:

10. Now type $MIN$, then click the button again to return to normal text.

11. To type the unit $cm^2$, first type $cm$, then click the Superscript button:

12. Now type 2, then click the button again to return to normal text.

13. Click Calculate All to calculate these expressions once you have entered them.

\[ \text{Min gross section area; } \, A_{MIN} = \frac{T_f}{F_a} = 27.273 \, cm^2 \]

14. You should find the result displayed in the document - if you have an error, turn to “Errors and Troubleshooting” on page 33.

15. Here are the final three paragraphs of the calculation. Follow the steps below to create these.

\[
\text{Effective length; } \, L_e = 5 \, m \\
\text{Slenderness limit; } \, \lambda_L = 300 \\
\text{Min. radius of gyration; } \, r_{MIN} = \frac{L_e}{\lambda_L} = ? \, cm
\]

16. Here we define two new variables to be used in the expression on the final paragraph.

17. Type the first paragraph, entering the subscript for the name $L_e$ as you did before.

18. Follow the steps below to enter the second paragraph.

19. Use the Greek Text button to enter the name $\lambda_L$

20. First click the button indicated, then type the Roman equivalent of the Greek letter – (l in this case for lambda).

21. Now click the button again to return to normal text, then enter the subscript suffix as you did above using the Subscript button.

A much easier way of entering Greek characters and more complex units is to use the Tedds Greek Characters, Tedds SI Units and Tedds US Units toolbars. Word 2003 users simply pick Tedds/Toolbars... menu option and check the appropriate options. Word 2007 - 2010 - 2013 users can select directly from the Tedds Tab on the ribbon.
22. Use **Copy** and **Paste** to enter this name in the final expression.

23. Now click **Calculate All** to calculate these final expressions:

   Min. radius of gyration; \( r_{\text{MIN}} = \frac{L_s}{\lambda_s} = 1.667 \text{ cm} \)

24. You should find the result displayed in the document - if you have an error, turn to “Errors and Troubleshooting” on page 33

5.8 Storing Variables in Tedds

1. Click the **Variables** button.

2. The **Variables** dialog will open, displaying the stored values.

3. You will note that we do not just store the variable name and value, but also the dimensions. This is how Tedds handles all the unit conversions for you.

   \[ \text{Note that you can Delete variables from this list if you wish:} \]

4. **Cancel** from this dialog, and edit one of the **values** on the page - say the tie force to \( Tf = 600 \text{ kN} \). Now check back in the stored variables and you will note the stored value **has not changed**.

5. **Re-calculate** the document and check back in the list of variables - the new value has now been stored.

   \[ \text{An important observation — the stored value of a variable only changes when you re-calculate the definition, not when you just edit it on the page. If you edit the value of a variable you must re-calculate the variable definition, and any calculations that use it to update them.} \]

5.9 More About Units in Tedds

1. Change the tie force back to its original value \( Tf = 450 \text{ kN} \). Calculate again to store this new value.

2. Look again at the **values** displayed in the **Variables** dialog. You will note that many of these values are not those displayed in the document.
3. The values in the dialog are in the *Base Units* in which Tedds performs all calculations and from which all the other units are *derived*. The base units are shown in the following table:

<table>
<thead>
<tr>
<th>Tedds Base Units</th>
<th>Metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>m</td>
</tr>
<tr>
<td>Mass</td>
<td>kg</td>
</tr>
<tr>
<td>Time</td>
<td>s</td>
</tr>
<tr>
<td>Temp</td>
<td>°C</td>
</tr>
</tbody>
</table>

If you hover over a variable name in the Variables dialog a summary list is displayed showing the value of the variable in all applicable standard units.

4. Note that our calculation does not include any conversion factors.

Tedds' unit handling is a massive help – Tedds comes with a huge number of defined units and you can add more if needed. **Dimensional Checking** - Tedds checks all dimensions in your calculation and will inform you if these are incorrect. This is why you should use units consistently throughout your calculations. Do so, and you can have total confidence that your calculations are dimensionally correct.

5. Save the document and give it a name - call it “Exercise 2” - as we wish to build on it later in the guide.

### 5.10 What Next?

Congratulations! You have completed your first Tedds calculation. You can now begin writing effective calculations in Tedds for Word. There are more great features that make such calculations even more powerful, and we will show you these later.

Right now we will take a brief look at handling errors in calculations.

### 5.11 Errors and Troubleshooting

The problem with a lot of guides is they only show you the right way to do things, and then you have no idea what to do when something goes wrong! Let's look at a couple of errors and how to fix them.

1. If you have an error in your calculations, Tedds will inform you when you calculate your document and the error is encountered. The first thing you should do is *interrupt* the calculation process.
2. If you have jumped to this section because you have encountered an error previously, then click the *Interrupt* button in the dialog (see step 10 below), review the details from step 11 onwards and then return to fix the error in your calculations and continue with the exercise.

3. If your previous calculations were error free, then you will have had no need to look at this section. We shall therefore create some calculations which do have errors so that we can see how to handle them. Open a new blank document for this example.

4. Click the *Tedds Options* button.

5. The *Options* dialog will open, click on the *Calculating / General* page.

6. Make sure that the options above are checked and then click *OK*. We can now proceed to create some calculations with errors.

7. Enter the following 2 paragraphs as they appear here - see if you can spot any errors as you do, but don't fix them yet!

\[
\begin{align*}
\text{wL} &= 4.5 \text{ kN/m}^2 \\
\text{wD} &= 2.5 \text{ kN/m}^2 \\
\text{wT} &= \text{wL} + \text{wD} = ? \text{ kN/m}^2
\end{align*}
\]
8. Now click the *Calculate All* button to calculate the calculations - you should see the *Expression Error* dialog:

9. Tedds flags the *first* error, and gives you some help in fixing it.

10. When you are ready, click the *Interrupt* button. Tedds highlights the error for you in the document as shown below:

\[
\begin{align*}
wL &= 4.5 \text{kN/m}^2 \\
wD &= 2.5 \text{kN/m}^2
\end{align*}
\]

Once we fix the problem and re-calculate this error messages will automatically disappear.

11. Check the rule about *delimiters* (see “The Standard Variable Definition Explained” on page 29) There should be a semi-colon between the expressions to separate them. Add this in and re-calculate the entire document.

\[
wL = 4.5 \text{kN/m}^2 \\
wD = 2.5 \text{kN/m}^2
\]

12. Now we will get the next error – the variable WD is not defined. We have typed *WD* instead of *wD* and variable names are *case-sensitive*.

13. Click the *Interrupt* button to stop the calculation.

14. Correct the variable name on the page to *wD* and re-calculate. The calculations should now complete with no problems. Tedds automatically deletes all error messages from the page.

5.12 *What Now?*

When you have successfully completed this section, you can move onto the next topic. Now we are going to look at using calculations from the *Engineering Library* in Tedds for Word.
6 Using Library Calculations in Tedds for Word

6.1 Why use Library Calculations in Tedds for Word?
We have shown that you can write your own calculations in Tedds for Word, but you can also use the Library Calculations. The advantage of this is that you can add additional text to your output easily, because it is already in a Word document. You can also combine more than one calculation in a document, add pictures and tables - anything you need to create a polished report. And if you need to update the calculations you can do it directly in the document.

Sometimes, of course, you just need an answer right now and the polishing can wait. That’s why we have Tedds too. With the two modes, you have both bases covered.

6.2 Exercise 3: Using Library Calculations in Tedds for Word
In this exercise we will use the Timber beam analysis & design (EN1995) calculation to show you how to run a typical calculation from the extensive Engineering Library in Tedds for Word.

Allow about 15 minutes to complete this exercise.

Analysis Information
Use the following information for the calculation.
Beam span = 3000 mm
Supports: Vertical = Restrainted
Rotational = Free

Loading
Self Weight factor = 1
Dead Load Full UDL = 2 kN/m
Imposed Load Full UDL = 3 kN/m
Load Combination 1 = 1.35 x Dead + 1.5 x Imposed
Design Information

Use the following information for the calculation.
Type of beam = Flitch
Breadth of timber members = 44 mm
Depth of timber members = 195 mm
Number of timber members = 2
Timber grade stresses = C24
Service class of timber = 1

Breadth of steel members = 8 mm
Depth of steel members = 190 mm
Number of steel members = 1
Steel design stress = 235 N/mm²

Design Information (Continued)

Bolt diameter = M12
Maximum bolt spacing = 475 mm
Length of bearing = 100 mm
Compressive edge of beam = Restrainted
Duration of loading = Long term

Maximum allowable deflection = 0.003 x span

6.3 Buttons used in this Exercise

The new commands you will be introduced to in this exercise are located on the Tedds tab as shown below:

6.4 Using Calculation Sections in Tedds for Word

As stated, one of the reasons for running library calculations in Tedds for Word is so that you can combine a number of calculations in a single document. In this case, each calculation should be placed in a separate Calculation Section, so we will start off by introducing these. For more information on this topic see “Calculation Sections Explained” on page 43.

1. Open a new document.

2. Insert a New Calc Section by clicking the appropriate button.
3. The following dialog will appear - enter a name for the section. This will form the title for the calculation in the document.

![Add Calc Section dialog](image)

4. Click OK and this will enter a *Calculation Section Title* in the document. We place a calculation *below* this title and thus *within* the section. You should note that your cursor is now on the line below the section title.

### 6.5 Selecting Calculations from the Library

All the library calculations are available from the *Library Access System*. To use a calculation we retrieve it from the *Library*, place it in our document and calculate it.

1. If it is not open already, launch the *Library Access System*.

2. Click the *Index* button if the index is not displayed and ensure you have the *Tedds calculations* index option selected.

3. To open a folder in the index simply double-click it. Open the *Beams* folder, then the *Timber beam analysis & design (EN1995)* folder. Then select (click on) the *Timber beam analysis & design (EN1995)* item.
4. To place this calculation in the document, click the *Execute* button in the library. (You can also double-click on the selected item to do this.) In both cases you will see the *Insert Calc Item* dialog.

![Insert Calc Item dialog]

5. This dialog allows you to control where the item will be added. Simply choose the options as above then click *OK* and the item will be pasted at **the cursor position** in the document.

Note that you can also create a Calc Section directly from the *Insert Calc Item* dialog.

6. You should now have the following in your document.

**FLITCH BEAM DESIGN**

Timber beam analysis & design (EN1995-1-1:2004)

7. We can now close the *Library* - there is no need to have it open while a calculation is running.

8. Click the *Calculate Calc Section* button to start the calculation.
9. The Interface for the calculation will now be displayed, along with the Progress Log. You are now in familiar territory as everything from this point works exactly as you learned in the first exercise – Using Tedds (page 11)

10. You will be comfortable with entering information in the interface by now, so we won't show every page in the guide. The data to be entered is given under Analysis Information on page 36.

11. Click on the Geometry... button, enter the span and support data then click OK.

12. Click Loading... and then + Add Load twice. Enter the Dead and Imposed loads in the two new rows provided, specify the imposed type as variable, then click OK.

13. To define the load combination as specified, click on the Combinations... button - as the factors are the those we require, simply click OK.

14. Define the type of beam as Flitch before clicking on the Member Details... button. Then enter the data given under Design Information on page 36.

15. To enter the timber grade stress you will need to click on the Timber properties... button.

16. When you get to enter the Service class of timber, note the help information available for this input displayed in the information pane (as shown below).
17. Enter the rest of the design information from page 36, any data not specifically defined can be left as the default value.

18. Click **OK** to return to the previous page of the interface and you will see the calculations have been performed and utilisation ratios determined while you are still in the interface.

19. The interface shows values for the *Duration of loading* and *Maximum allowable deflection*. These are the values we want, so there is no need to change them.

20. If the design is not satisfactory it is a simple matter to use the **Member details...** button to adjust the section to achieve a satisfactory design. You should find that the flitch beam passes all the checks so click **Finish** to close the interface and place the calculations into the document.

21. Close the *Progress Log* and examine the calculations - they are of the same form as the ones you saw in Tedds, and they show you exactly how the results have been determined.

### 6.6 Viewing Hidden Text in Tedds for Word

Some calculations are hidden however. There is a slightly different way of viewing **Hidden Text** in Tedds for Word.

1. Check the **Hidden Calcs** box to view these.

2. Check the button again to re-hide text.
6.7 **Re-calculating in Tedds for Word**

This is accomplished in a similar manner to Tedds.

1. Click the *Calculate Calc Section* button.

2. The calculation will now run again - try changing some of the input data in the interface.

3. **DO NOT** overtype values on the page prior to re-calculating - this is not the way to change input data when using *our* library calculations (as distinct from ones you have written yourself in the manner shown in the previous section of the guide) in Tedds for Word.

6.8 **Adding another calculation to the document**

To start a new calculation in this document create a new Calculation Section.

1. Place your cursor below your existing calculations.

2. Click the *Add New Calc Section* button.

3. Type a name for the new section – this will be the title of your next calculation. Then click *OK*.

4. A new calculation should be placed below this title and thus within the section.

5. Retrieve another calculation from the library and place it within this section.

6. To calculate just one section, we place our *cursor* within the section and use the *Calculate Calc Section* button.
6.9 What Next?

Congratulations! You have completed the third exercise of the guide and learned all you need to run calculations from the Library in Tedds for Word.

You can now save the document and re-use it as appropriate.

In the next section you will learn how you can make your own calculations even more powerful.

Calculation Sections Explained

Refer back to the section “Storing Variables in Tedds” on page 32. You will note that here we have just one list of saved variables, known as Document variables, as we have not used Calculation Sections. When we use Calculation Sections, Tedds for Word saves the variables for each calculation in a separate list unique to each section. These are known as Section variables. This ensures that all your input values are retained separately from those for another calculation.

When you need to update a single calculation within a document that contains many calculations, simply place your cursor within that section and use the Calculate Calc Section command. Place your cursor within the first section in your document, and click the Variables button to view the unique list for this part of the document.

Tedds for Word also has commands which enable you to manipulate the calculation sections in your document. You can delete a calculation section, copy it, paste it into a new location in your document and change its name.
7 Writing Tedds Calculations - Stage 2

7.1 Exercise 4: Using Math and Data functions and Formatting Results
In this exercise we will build on the calculation we wrote in Exercise 2 to extend its capabilities and introduce some more Tedds features.

Allow about 30 minutes to complete this exercise.

7.2 Buttons used in this Exercise
The new commands you will be introduced to in this exercise are located on the Library and Show/Hide groups of the Tedds tab as shown below:

7.3 Defining Input Variables
1. Open the document you created in exercise 2 - “Exercise 2”.
2. Here are the new calculations we will add to check the adequacy of an actual section:

Check section:
Try a 152 x 89 x 24 Rolled Steel Channel
Section properties; A = 30.42 cm\(^2\); \( r_{xx} = 6.20 \) cm; \( r_{yy} = 2.66 \) cm
Design radius of gyration; \( r_d = \min (r_{xx}, r_{yy}) = ? \) cm
Actual stress; \( f_a = \frac{T_f}{A} = ? \) N/mm\(^2\)
Actual slenderness; \( \lambda = \frac{L_e}{r_d} = ? f1 \)

1. Type the first two paragraphs, which are just text, below the existing calculation.
2. Type the third paragraph and note that here we are defining three input variables which are properties of the section we are checking. Ensure you separate the text and all the expressions using delimiters (:) as shown.

Section properties: \( A = 30.42 \text{ cm}^2; \quad r_{xx} = 6.20 \text{ cm}; \quad r_{yy} = 2.66 \text{ cm} \)

7.4 Tedds Math Functions
3. Now type the fourth paragraph. Note how the Tedds math function \( \text{min} \) is used here.

Design radius of gyration; \( r_d = \text{min} (r_{xx}, r_{yy}) = \) ? cm

A math function is always followed directly by its argument(s) in parentheses as shown here. There are many more such functions available in Tedds for Word.

For full details of this and other functions, consult the Tedds Help system topic Tedds Mathematics/ Functions, or use the Calc Writing Aids set from the Library Access System, where all functions are completely documented.

1. Now type the fifth paragraph - this is a simple expression that determines and displays the actual stress in the section and assigns the result to the variable \( f_a \).

7.5 Result Accuracy and Formats
It is sufficient to display the slenderness to one decimal place. To do this we use a format string to override the default result setting of three decimal places.

1. Now type the last paragraph of the new calculations as follows. Use the Greek text button as you did on page 31 for the variable name \( \lambda \).

Actual slenderness; \( \lambda = \frac{L_e}{r_d} \) = ?

2. The characters \( f1 \) following the ? are the format string. The format string must immediately follow the ? with no space in between as shown. See below for a fuller explanation.

3. Once you have finished typing this last expression, check the new paragraphs carefully. Have you included all the delimiters? Have you used subscripts correctly? Have you used the correct case for variable names and units?

4. When you are satisfied that everything is correct, click the Calculate All button.
5. If you have an Error, then Interrupt and see “Errors and Troubleshooting” on page 33. Fix any errors until your calculation works fully.

6. Review your results and look at the last paragraph to see how the format string we used has operated:

\[ \lambda = \frac{L_e}{r_d} = 188.0 \]

7. Click the Variables button to examine the list of saved variables and check the stored value for this variable:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Dimensions</th>
<th>Type</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>300</td>
<td></td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>( \lambda )</td>
<td>187.97</td>
<td></td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

### Result Format Strings Explained

You can override the default result setting, and reduce or increase the number of decimal places for a displayed result, by using a result format string after the ? result field. For example typing \(?f2\) will display the result to two decimal places. It is important that there is no space between the format string and the ?. The format string characters signify the following:

- \( f \) = fixed format, and \( 2 \) = result to be displayed to 2 decimal places (can be from 0-15)

Note that format strings only control the precision of the result displayed in the document, not any result that is stored by Tedds.

For full details of this and other result formats, consult the Tedds Help system topic Tedds Result Formats/ Format Strings.

### 7.6 Using Data functions in calculations

The calculation as written is very useful, but we can enhance it further. One big improvement is to include a Data List in the calculation, making the properties of a huge number of types and sizes of sections instantly available.

1. First edit the two paragraphs underneath the heading ‘Check Section;’ as follows:

2. Delete the following text for the section name - *Try a 152 x 89 x 24 Rolled Steel Channel. Leave an empty line here.*
3. Next delete just the values for the properties of the section. Replace
them with a ? result field. You should end up with the following:

![Check section;](image)

Place cursor here

Section properties; \( A = ? \text{ cm}^2 \); \( t_{xx} = ? \text{ cm} \); \( t_{yy} = ? \text{ cm} \)

4. Finally, place your cursor as shown at the very end of the heading.

7.7 Retrieving Data Lists from the Library

5. Click the button to Launch the Tedds Engineering Data.

6. This opens a special Set in the Library where all the Data Lists and Data Tables are accessed. There is a lot of data in this set. We wish to find a Data List that includes steel RSCs suitable for a BS 5950 calculation.

   We will use the Find facility to help us locate such a table.

7. First select the Group we want to search in - British standards. Select Edit/Find in the library, and type in RSC as shown.

![Image of Library Access System]

8. Library Access System finds the first item containing RSC, this is not the item we require so click the green down arrow several times until the UK - hot rolled folder appears and the item shown below is highlighted.

   RSC data list
1. Now to bring this item into your calculation, either double click the item, or click the Execute... button. You should find the following has been entered in your document.

```
Check section;
DataList("euro.dis", "Rolled Steel Channels", "76(38(6))", "Try +", ");
Section properties; A = \( ? \) cm\(^2\); \( r_{xx} = ? \) cm; \( r_{yy} = ? \) cm
```

2. This text inserted is a Tedds Data List Field which launches the specified Data List (further details on Tedds Fields are given below),

3. Close the library once you have retrieved the Tedds Data List Field.

4. Now click Calculate All to calculate the document again.

5. The Data List will now be displayed when the Tedds Data List Field is calculated:

![Data List Interface]

6. Select the 152 x 89 x 24 channel section then click on the Details button to examine the variables defined in the table.

```
<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>I_x</td>
<td>1169.33306</td>
<td>cm(^4)</td>
</tr>
<tr>
<td>I_y</td>
<td>215.6555296</td>
<td>cm(^4)</td>
</tr>
<tr>
<td>I_z</td>
<td>215.6555296</td>
<td>cm(^4)</td>
</tr>
<tr>
<td>A</td>
<td>8.187568274</td>
<td>cm(^2)</td>
</tr>
<tr>
<td>W_t</td>
<td>2.652675773</td>
<td>cm(^2)</td>
</tr>
</tbody>
</table>

Check availability
Details - RSC 152x89x24
```

![Data List Details]

Note that we have used exactly the same names for the properties in our calculation as those defined by the Data List - \( A \), \( r_{xx} \), and \( r_{yy} \). This is the key to integrating all Data Functions with your calculations. Remember that variable names are case-sensitive.

7. Click the Select button to return these variables to your calculations - you will see that the section's properties from the Data List replace the \( ? \) fields in your document and the Tedds Field displays the choice you made in the Data List.

```
Try RSC 152x89x24:
Section properties; \( A = 30.418 \) cm\(^2\); \( r_{xx} = 6.198 \) cm; \( r_{yy} = 2.663 \) cm
```
8. The *Data List* is now integrated with your calculation. Re-calculate a few times, each time changing your selection of channel size in the *Data List*, to test this.

9. Click the *Variables* button and you will see that all the variables defined by the *Data List* are listed and are thus available to be used in calculations.

10. Save the calculation at this stage, as we will build on it in the final exercise.

11. *Data Tables* can be integrated with your calculations in exactly the same way.

### 7.8 Tedds Fields

12. Check the *Field Codes* box.

13. Look at the *Tedds Field* in your document and you will see the following:

   Check section;
   
   { =CSC|CALL DataList("euro.dis", "Rolled Steel Channels", 152(24))", "Try ")
   
14. The command that runs the *Data List* is now revealed. Uncheck the *Field Codes* box again to return to the normal view of the document.

---

#### Tedds Fields Explained

The *Field Codes* button enables you to see and thus edit the hidden commands which are *Tedds Fields*. These commands run special functions in Tedds like the *Data Lists*. We will see some more Tedds Fields shortly. A Tedds Field will run when it is calculated, like any normal expression. We hide the *Tedds field*, since you would not want it to appear in a printed report. The *Field Codes* button reveals the Tedds Fields. *Tedds Fields* should be treated like expressions, and separated from text and other expressions in the same paragraph using semi-colons.

---

### 7.9 What Next?

Congratulations! You have completed the fourth exercise and learned everything you really need to write powerful Tedds calculations. Maybe now would be the time to have a go at writing a calculation of your own. It’s a good idea to start with something simple and build on the complexity as you become more familiar with Tedds.

The next step in the guide is about making Tedds calculations still easier to work with, and is especially relevant if you envisage writing calculations for others to use. Even if your calculations are for your own use you may find...
these further features beneficial so we recommend that you review them. You might like to leave this step until you have had a go at writing a calculation of your own using what you have learned so far.
8 Enhancing Calculations

There is even more functionality available for our calculations than we have seen so far. Whether you use these enhancements depends both on the purpose of the calculation, and on the time you have available. Certainly these features are very useful when you are writing calculations which others will use (as we do at Tekla). Hence the Tedds library is packed with examples which use these features, and you have already seen many of them when running our calculations.

8.1 Exercise 5: Enhancing Calculations

In this exercise we will enhance the previous calculation and you will see what we are talking about.

 ALLOW ABOUT 15 MINUTES TO COMPLETE THIS EXERCISE.

8.2 Buttons used in this Exercise

The only new command you will be introduced to in this exercise is located on the Insert group of the Tedds Calcs ribbon as shown below:

8.3 Tedds Input Fields

The Tedds Input Field speeds up the editing and often the creating of input variables. We will replace all the existing variable definitions in the calculation:

1. Delete the entire definition for the \textit{Min. yield strength, Fy}, from your page. Leave your cursor on the empty line.

2. Click the \textit{Tedds Field} button.
3. The following dialog will appear. Enter the details shown to define the input for this variable:

Prompt = **Min. yield strength**
Name = **Fy**
Units = **N/mm²** (type the main part of the unit, click the superscript button (\(^2\)) and then type 2)
Default value = **275**
Format = **Fixed**
No. of decimal places = **0**

1. Note that we do not put a *value* in this dialog - this is entered when the statement is calculated. Note the following:

<table>
<thead>
<tr>
<th><strong>Prompt</strong></th>
<th>tells the user what the variable is and appears on the page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>the unique name of the variable</td>
</tr>
<tr>
<td><strong>Units</strong></td>
<td>if the property has dimensions then enter a unit here</td>
</tr>
<tr>
<td><strong>Default value</strong></td>
<td>this value will be displayed initially for user to edit or accept</td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td>the format displayed on the page</td>
</tr>
<tr>
<td><strong>No. of decimal places</strong></td>
<td>the number of decimal places displayed on the page</td>
</tr>
</tbody>
</table>

1. Accept the defaults for other options and click **OK** when you have everything entered.

2. The following will appear on the line containing your cursor:

```plaintext
;  Min. yield strength;  Fy = ?F0 N/mm²;
```

3. With the **Field Codes** button on you will see the following Tedds Input Field preceding the text on the line:

```plaintext
{ =CSC\CALL Input("Min. yield strength","Fy","N/mm^2","275",1) };
```

```plaintext
Min. yield strength;  Fy = ?F0 N/mm²;
```
4. Calculate your document to run it:

5. The Set Variable Value dialog appears, as shown above.

6. Because we already have a value defined for this variable it is displayed in the input. You can accept it, or edit it as required. There is no need to find and edit the variable value on the page, as it is automatically updated when you enter a value in the Set Variable Value dialog.
7. Delete and replace the 3 remaining variable definitions in the same manner – the table below shows what you need to enter in the *Insert Tedds Field* dialog for each of the three variables in order from left to right. When you have done this, recalculate your document to ensure that your definitions are correct.

<table>
<thead>
<tr>
<th>Property</th>
<th>Input</th>
<th>Le</th>
<th>(\lambda_L)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>(\text{Tf})</td>
<td>Tie effective length</td>
<td>Slenderness limit</td>
</tr>
<tr>
<td>Name</td>
<td>(\text{Tf})</td>
<td>(L_e)</td>
<td>(\lambda_L)</td>
</tr>
<tr>
<td>Units</td>
<td>(kN)</td>
<td>(m)</td>
<td></td>
</tr>
<tr>
<td>Default value</td>
<td>fixed</td>
<td>fixed</td>
<td>300</td>
</tr>
<tr>
<td>Format</td>
<td>fixed</td>
<td>fixed</td>
<td>fixed</td>
</tr>
<tr>
<td>No. of decimal places</td>
<td>2</td>
<td>3</td>
<td>0</td>
</tr>
</tbody>
</table>

To enter *Greek* characters in the *Insert Tedds Field* dialog for variable names like \(\lambda\) simply click the Greek character button (\(\lambda\)) and then type in the equivalent Roman character, in this case you need to type \(l\) (i.e. lowercase letter \(L\)) to get \(\lambda\).

To enter *Subscript* or *Superscript* characters simply click the Subscript or Superscript button (\(\text{\textsubscript{}}\) \(\text{\textsuperscript{}}\)) and then continue and type in the subscript or superscript. Once you have reached its end click the button again to switch back to typing normal text.

The *Default* value is entirely optional. If you enter one it will be displayed the first time a calculation is run, otherwise the input box will be empty. Delete the stored variables and re-calculate to see the defaults in operation.

8.4 *Tedds Show Fields*

The final thing we would like the calculation to do is automatically assess our section and report in the document whether our chosen section is passing or failing and, if it is failing, why. We use a *Tedds Show Field* to do this.
1. Enter the following two paragraphs after your existing calculations:

\[
\text{Check stress; } \quad \text{check\_stress} = \frac{f_s}{f_a} = \\
\text{Check slenderness; } \quad \text{check\_slender} = \frac{\lambda_s}{\lambda_a} = 
\]

2. These last two values help us assess the utilisation of the section for the two checks. Assigning them to output variables will help us with creating Tedds Show Fields. Calculate your document once you have written them to ensure they are working properly before proceeding.

3. Place your cursor beneath these paragraphs and click the Insert Tedds Field button.

4. Select the Show tab. The Show Field we want to create will test whether the section is failing stress and output a message to give the status of the check.

5. Select the Condition type option and input the following information:

6. The output of the Tedds Show Field consists of two text messages known as output strings. Only one output string is displayed in the document depending on the status of the condition.

7. Check your input carefully, then click OK to enter the Tedds Show Field in the document.

8. When you have OK'd the input, click the Field Codes button to view the resulting Tedds Show Field. It should be as shown below. If your Tedds Show Field is incorrect, the best thing to do at this stage is to delete it and run through the Insert Tedds Field dialog again.

\[
\text{if(check\_stress > 1,"Section fails stress check","Section OK for stress")} \Rightarrow \text{Show, True, True})};
\]

8.5 Using Logic In Tedds

9. Take a close look at this Tedds Show field, and you can see how we use a simple logic statement to output one of two pieces of text using the if logical operator.

\[
\text{if(check\_stress > 1, “Section fails stress check”, “Section OK for stress”)}
\]

The general form of this logic expression is as follows:
1. Now calculate your document to calculate the Tedds Show Field. You should find you have something similar to the following in your Progress Log and you will also see the output text on the page where you placed the Tedds Show Field.

2. Change some of your input values and re-calculate a few times to test your full calculation and both the pass and fail output of the Tedds Show Field.

### 8.6 What Next?

Congratulations! You have completed the final exercise in the guide and are ready to begin using Tedds to its full potential.

Here are a few things you could try next:

- Create another Tedds Show Field similar to that above for the slenderness check - following is the logic statement you would use for this:

  ```
  Condition: check_slender > 1
  ```

- Create a Tedds Show Field to give the overall status of the section, checking both slenderness and stress. Try the following:

  ```
  Condition: and(check_stress <= 1, check_slender <= 1)
  Yes: PASS
  No: Section fails!
  ```

- Take a look at Tedds Message Fields. The input for these is the same as Tedds Show Fields but their output is displayed in a Message box, rather than in the document. You will see examples of their use in the Tedds Engineering Library Calculations, for example the RC Footing design calculation.

- Try creating Messages using the Value of Variable option to show the values of the minimum area and radius of gyration in the Log before the Data List is displayed.
Of course there's much more for you to discover. We wish you an enjoyable and productive time in using the program in your day-to-day work, and exploring its capabilities more fully.

If you would like to read up on further information about Tedds, then we would recommend the Tedds User’s Guide. You will find this in the Documentation folder within the folder to which you installed Tedds. The manual is in the electronic .pdf format. The information in the manual is also available within the Tedds Help system, which you can access in the usual way.

Some Tedds dialogs have context sensitive help. To see this simply click the Help button in the dialog.

We also run training courses in most locales, for further information on availability contact the Tedds support team in your region, simply click the Support icon in any of Tedds’ automated calculations.